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1. About Kernel for Novell GroupWise to Exchange 

Welcome to the user manual for Kernel for Novell GroupWise to Exchange, result oriented and effective 
email migration software that helps you to migrate from Novell GroupWise to MS Exchange Server. It 
easily exports user mailboxes, calendar, tasks, trash items, sent items, documents, checklist, work in 
progress, cabinet, Unicode characters, journals, notes, archives, personal address books and all the 
existing folders from GroupWise mailboxes and stores them in the user's new mailboxes on MS Exchange 
Server or to Personal Storage Files(.PST). 

Kernel for Novell GroupWise to Exchange software provides secure migration to MS Exchange Server. 
Users can migrate Single GroupWise Mailbox or Unlimited GroupWise Mailboxes at once. 

This user manual comprises step by step guidelines on using Kernel for Novell GroupWise to Exchange. 

1.1  Using this Manual 

This user manual is intended to guide users on using Kernel for Novell GroupWise to Exchange. We 
suggest that first time users should read this user manual completely and carefully before proceeding to 
use the software. However, if you are an experienced user, you can use the table of contents to find out 
information pertaining to the tasks that you need to perform by using Kernel for Novell GroupWise to 
Exchange. You can use the table of contents to navigate through different sections of this user manual. 
The table of contents lists all the sections that are contained in this user manual in chronological order. 
The user manual comprises the following sections: 

 About Kernel for Novell GroupWise to Exchange 

 Getting Started 

 Migration from Novell GroupWise to Exchange Server 

 Advance Options to Make the Migration More Efficient 

 Difference between Evaluation and Full Version 

 Purchase and Support 

 Legal Notices 

Certain abbreviations have been used throughout this manual. For clear understanding of the contents of 
this user manual, please go through the list of abbreviations, mentioned below, before reading the manual. 

1.1.1 List of Abbreviations 

PST: Personal Storage Files 

XLS: Excel Sheet Extension 

MS: Microsoft 
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RAM: Random Access Memory 

MB: Mega-Byte 

GB: Giga-Byte 

1.2  Who should use this Software? 

The capability and potential of Kernel for Novell GroupWise to Exchange software to perform the migration 
smoothly and accurately makes it the preferred and best choice for organizations that want to switch from 
Novell GroupWise to MS Exchange Server, which generally takes days and hours to complete. 

The software is also helpful to Administrators and Technicians, who need to perform migration from Novell 
GroupWise Server to Microsoft Exchange Server, so their organizations can avail the advance 
functionalities of MS Outlook which is used in collaboration with MS Exchange Server. The need of 
migration from Novell GroupWise to MS Exchange Server arises due to accessibility issues, server 
maintenance charges, security reasons and increased help desk cost associated with Novell GroupWise 
server. 

1.3 Introduction 

Once you download the software setup of Kernel for Novell GroupWise to Exchange, two applications get 
installed on your system. One is the main application – Kernel for Novell GroupWise to Exchange software 
and second is a batch file creation tool – Kernel for Novell GroupWise to Exchange Migration File Creator. 
Both the applications are discussed below. 

1.3.1 Kernel for Novell GroupWise to Exchange 

Kernel for Novell GroupWise to Exchange is an advanced and result oriented email migration software 
that easily exports every item of GroupWise User Mailbox i.e. emails, contacts, calendars, sent items, 
trash items, documents, check list, Unicode characters, cabinet, work in progress, journals, notes, 
appointments, archive items, etc. 

Two choices are available to the user for migration - Single Mailbox Migration and Multiple Mailboxes 
Migration. Single Mailbox Migration option converts one mailbox at a time whereas Multiple Mailboxes 
Migration option converts unlimited mailboxes at a time. 

1.3.1.1 Salient Features 

 Migrates from GroupWise to Exchange 

 Converts Single GroupWise Mailbox 

 Converts Batch of GroupWise Mailboxes 

 Batch file migration through imported MS Excel worksheets 

 Migrates archived GroupWise items 

 Migrates complete Address Books 
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 Migrates securely and accurately 

 Saves converted mailboxes in PST or MS Exchange Server user profile 

 Supports every version of Novell GroupWise, MS Exchange Server, MS Excel and MS Outlook 

 Free Evaluation version to analyze the software 

1.3.1.2  Graphical User Interface 

Now that Kernel for Novell GroupWise to Exchange has been installed on your computer, you can start 
using the software after getting acquainted with the software interface. 

Menu Bar 

The menu-bar of Kernel for Novell GroupWise to Exchange comprises three main menus– File, Tool and 
Help. 

File Menu 

The File menu comprises four menu items. 

 

Figure 1.1: File Menu of Main Application 

Menu items in the File menu: 

Field Name Field Description 

Single Mailbox Select to convert Single GroupWise User mailbox 

Batch File Select to convert Multiple GroupWise user mailboxes saved in a 
NUCON batch file 

Export Select to export/save items of the mailbox 

Exit Select to close the software 
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Tool Menu 

The Tool menu comprises one menu item. 

 

Figure 1.2: Tool Menu of Main Application 

Menu items in the Tool menu: 

Field Name Field Description 

Advance 
Options 

Select to view advanced options to customize various activities 

Help Menu 

The Help menu comprises three menu items. 

 

Figure 1.3: Help Menu of Main Application 

Menu items in the Help menu: 

Field Name Field Description 

Help Select to view Users Help Manual of Kernel for Novell GroupWise 
to Exchange 

Software home 
page… 

Select to visit homepage of the software on our website 

About Kernel 
for Novell 
GroupWise to 
Exchange 

Select to know version information and support details of Kernel 
for Novell GroupWise to Exchange 
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Tool Bar 

The tool-bar in Kernel for Novell GroupWise to Exchange is displayed below the menu-bar. The tool-bar 
provides a convenient and user-friendly method to perform certain actions that can also be performed by 
using the menu-bar. Read the information in the table below to find out about the tool-bar buttons: 

Button Button Name Button Description 

 

Single Mailbox Select to convert Single GroupWise User 
mailbox 

 

Batch File Select to convert Multiple GroupWise user 
mailboxes saved in a batch file 

 

Export Select to export/save items of the mailbox 

 

Help Select to view Users Help manual of Kernel for 
Novell GroupWise to Exchange software 

 

Buy Online Select to purchase Kernel for Novell GroupWise 
to Exchange software 

Status Bar 

Status bar is displayed at the bottom of the software window. The text „www.nucleustechnologies.com‟ is 
displayed on the status bar when you open the software. This text changes according to the actions 
performed with the tool bar buttons. For example- Status bar displays the text „Single File‟ when you put 
mouse on Single File button to perform single file conversion and then changes back to 
„www.nucleustechnologies.com‟. 

The Status bar also displays the text „CAP‟, „NUM‟, „SCRL‟ which respectively correspond to the Caps 
Lock, Num Lock, and Scroll Lock keys on your keyboard. If any of these keys are pressed, the color of the 
corresponding text will turn blue/black. 

 

Figure 1.4: Status Bar of Main Application 
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Buttons Used 

Apart from the standard options available in the menu-bar and the tool-bar, following are the main buttons 
used throughout the software working. 

 

Click to go to the next screen 

 
Click to go back to the previous screen 

 
Click to exit from the software 

 

Click to save/export items of the user mailbox 

 
Click to stop the saving/scanning process 

Customize User Interface 

You can add or remove toolbar buttons by clicking: 

  Add or Remove Buttons  Standard in the toolbar and selecting appropriate buttons. 

1.3.2 Kernel for Novell GroupWise to Exchange Migration File Creator 

Kernel for Novell GroupWise to Exchange Migration File Creator creates a .NUCON batch file that lists 
and records details of unlimited GroupWise user mailboxes for conversion to PST or MS Exchange 
Server. Batch file eliminates the pain of converting GroupWise User Mailboxes one by one. Creation of 
batch file saves the valuable time of administrators/technicians. 

Kernel for Novell GroupWise to Exchange Migration File Creator has the feature of importing MS Excel 
worksheet that is used to store complete information about the Novell GroupWise user mailboxes. 

1.3.2.1 Graphical User Interface 

As the batch file creation tool - Kernel for Novell GroupWise to Exchange Migration File Creator has been 
installed automatically on your computer system with the installation of Kernel for Novell GroupWise to 
Exchange software; you can start creating batch file to perform multiple mailboxes migration after getting 
acquainted with the software interface of batch file creator tool. 

Menu Bar 
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The menu-bar of Kernel for Novell GroupWise to Exchange Migration File Creator comprises four main 
menus – File, Edit, View, and Help. 

File Menu 

The File menu comprises six menu items. 

 

Figure 1.5: File Menu of File Creator 

Menu items in the File menu: 

Field Name Field Description 

New File Select to remove all existing records listed in the Kernel for Novell 
GroupWise to Exchange Migration File Creator software and 
create new record for a new batch file 

Add Record Select to add new record of the user mailbox in a batch file 

Open Select to open an existing .NUCON batch file 

Save Select to save the .NUCON batch file 

Save As Select to select the location on your hard drive to save the 
.NUCON batch file 

Exit Select to exit from the software 

Edit Menu 

The Edit menu comprise of single menu item: 
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Figure 1.6: Edit Menu of File Creator 

Menu items in the Edit menu: 

Field Name Field Description 

Remove Select to remove the selected record from the list 

View Menu 

The View menu comprises two menu items. 

 

Figure 1.7: View Menu of File Creator 

Menu items in the View menu: 

Field Name Field Description 

Toolbars Select to view or hide toolbar of Kernel for 
Novell GroupWise to Exchange Migration File 
Creator software 

Status Bar Select to view or hide status Bar of Kernel for 
Novell GroupWise to Exchange Migration File 
Creator software 

Help Menu 

The Help menu comprises three menu items. 

 

Figure 1.8: Help Menu of File Creator 
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Menu items in the Help menu: 

Field Name Field Description 

Help Select to view help information pertaining to performing 
various tasks using Kernel for Novell GroupWise to 
Exchange Migration File Creator 

Software Homepage Select to visit homepage of our website 

About Kernel for Novell 
GroupWise to Exchange 
Migration File Creator 

Select to view version-related and support information of 
Kernel for Novell GroupWise to Exchange Migration File 
Creator 

Tool Bar 

Following are the tool bar buttons used in the Kernel for Novell GroupWise to Exchange Migration File 
Creator: 

Button Button Name Button Description 

 

New Select to remove all existing records listed in the 
Kernel for Novell GroupWise to Exchange 
Migration File Creator software and create new 
record for a new Kernel batch file 

 

Open Select to open the existing .NUCON file 

 

Save  Select to save the .NUCON batch file 

 

Save As Select to define the location on your hard drive to 
save the .NUCON batch file 
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Add Record Select to add the records/details of the 
GroupWise user mailbox and saving options 

 

Remove Select to remove the selected record from the list 

 

Help Select to view User's Help Manual of Kernel for 
Novell GroupWise to Exchange Migration File 
Creator software 

 

Import Excel Select to import excel worksheet with added 
information about the batch of GroupWise 
mailbox(s) to be migrated 

Status Bar 

Status bar is displayed at the bottom of the software window. The text „Ready‟ is displayed on the status 
bar if Kernel for Novell GroupWise to Exchange Migration File Creator is ready to be used. Status bar also 
displays the text „CAP‟, „NUM‟, „SCRL‟ which respectively correspond to the Caps Lock, Num Lock, and 
Scroll Lock keys on your keyboard. If any of these keys are pressed, the color of the corresponding text 
will turn blue/black. 

 

Figure 1.9: Status Bar of File Creator 

Customize User Interface 

You can add or remove toolbar buttons by clicking: 

  Add or Remove Buttons  Standard in the toolbar and selecting appropriate buttons. 

  



© N u c l e u s  D a t a  R e c o v e r y . C o m  P r i v a t e  L i m i t e d   

2. Getting Started 

Now that you have understood the features and potential of Kernel for Novell GroupWise to Exchange, 
you are ready to get hands on experience of the software. To start migrating files, you will first need to 
download and install this software. However it is strongly recommended that before installing Kernel for 
Novell GroupWise to Exchange, you should go through the installation pre-requisites for the software to 
ensure that your computer is appropriately configured to run the software. 

2.1 Installation Pre-requisites and System Requirements 

The various pre-requisites for installing and running Kernel for Novell GroupWise to Exchange can be 
broadly classified into two major categories – Hardware requirements and Software requirements. 

2.1.1 Hardware Requirements: 

The hardware requirements for installing the software are as follows: 

 Pentium Class Processor 

 Minimum 64MB RAM (128 MB recommended) 

 10MB for Software installation 

 Disk Space - Enough space to save the results 

 You should have at-least 10 MB of free disk space if you want to export and save 10 
MB .PST file. 

2.1.2 Software Requirements: 

The software requirements for installing the software are as follows: 

2.1.2.1 Operating System Requirements 

Supported operating systems:  

 Windows Vista 

 Windows XP 

 Windows 2003 

 Windows 2000 

2.1.2.2 Novell GroupWise Server Requirements 

Supported Novell GroupWise Server versions: 
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 Version 6, 6.5, 7 

2.1.2.3 MS Outlook Requirements 

Supported MS Outlook versions: 

 MS Outlook 97 and above (97, 98, 2000, 2003, 2007) 

2.1.2.4 MS Exchange Server Requirements 

Supported MS Exchange Server versions: 

 All versions of MS Exchange Server 

2.1.2.5 MS Excel Requirements 

Supported MS Excel versions: 

 MS Excel 97, 98, 2000, 2002, 2003 and 2007 

2.2 Downloading Kernel for Novell GroupWise to Exchange software 
for the First Time 

After checking your computer with the prescribed system requirements for Kernel for Novell GroupWise to 
Exchange, you can download and install the software on your computer. You can buy the full version of 
the software from any one of our authorized resellers– Element5, Asknet and 2CO. 

If you want to try using Kernel for Novell GroupWise to Exchange before buying it, you can download the 
evaluation version from the following link: 

http://www.nucleustechnologies.com/download-groupwise-to-exchange.php 

 You can export unlimited GroupWise files saved on your system by using the 
evaluation version of Kernel for Novell GroupWise to Exchange; however, the 
evaluation version lets you save 10 emails per folder of the converted GroupWise 
mailbox. 

2.3 Installing Kernel for Novell GroupWise to Exchange 

After downloading the installer file for Kernel for Novell GroupWise to Exchange, you can install the 
software by running the file. 

To install Kernel for Novell GroupWise to Exchange: 

1. Double-click the Kernel for Novell GroupWise to Exchange installer. Follow the on-screen instructions.  

The Setup Installation Complete screen will be displayed. 

2. Click Finish to launch the software. 

http://www.nucleustechnologies.com/download-groupwise-to-exchange.php
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 When you run the Kernel software setup, two programs gets installed in the All 
Programs menu and two desktop icons are created: Kernel for Novell GroupWise to 
Exchange.exe and Kernel for Novell GroupWise to Exchange - Batch Migration File 
Creator.exe 

2.4 Un-installing Kernel for Novell GroupWise to Exchange 

You may need to uninstall and re-install Kernel for Novell GroupWise to Exchange. To uninstall Kernel for 
Novell GroupWise to Exchange: 

1. Click the Start  All Programs Kernel for Novell GroupWise to Exchange  Uninstall Kernel 
for Novell GroupWise to Exchange 

A warning message will be displayed. 

2. Click „Yes‟ to uninstall Kernel for Novell GroupWise to Exchange. 

 Before proceeding to uninstall Kernel for Novell GroupWise to Exchange, you must 
ensure that the software is not running. 

You can alternatively uninstall Kernel for Novell GroupWise to Exchange from the Control Panel by 
performing the following steps: 

1. Click the Start Menu  Control Panel and then double click the Add or Remove Programs icon. 

2.  Select Kernel for Novell GroupWise to Exchange and click Remove. 

A warning message will be displayed. 

3. Click „Yes‟ to uninstall Kernel for Novell GroupWise to Exchange. 
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3. Migration from Novell GroupWise to Exchange 

Server 

Now that you have complete familiarity of the user interface of Kernel for Novell GroupWise to Exchange, 
you are ready to perform the migration of GroupWise mailbox(s). 

3.1 Single Mailbox Migration 

1. Launch Kernel for Novell GroupWise to Exchange software. 

 

Figure 3.1: Main window of Kernel for GroupWise to Exchange 

2. Select the radio button „Select this option to convert single GroupWise Mailbox‟ and click Next 
button. 

On clicking „Next‟, window displays three modes to connect to the mailboxes of Novell GroupWise and 
archive selection option: Default Mode, Login Mode and Command Line mode. 
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Figure 3.2: Window showing three modes 

3. Choose any of the modes as per the requirement and perform migration of Single GroupWise mailbox. 

 Default mode: This mode converts the items of currently opened mailbox in GroupWise Client. 

 Login Mode: This mode provides sub-modes, where mailboxes can be connected and converted 
with Online details, Caching Mailbox Path and Remote Mailbox path of the mailbox file. 

 Command Line Mode: This mode helps to access and convert GroupWise mailbox without 
accessing or opening the GroupWise Client. Items of the mailbox are easy to convert by typing 
complete mailbox path: /pr-/"mailbox destination location" 

3.1.1 Default Mode 

Default mode migrates the currently opened user mailbox in Novell GroupWise client. 

1. Select the "Use Default" option to connect to the GroupWise mailbox in Default mode. 
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Figure 3.3: Using Default Mode 

 This option is enabled by default in the software. 

2. Activate and select the Archive file options to migrate archived emails. Click Next button to continue. 

Software shows all the existing folders in a tree like structure. 

3. Select any of the tabs to view the preview of selected email either in Text or HTML format. 
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Figure 3.4: Preview Window 

Emails, calendar, contacts and other items will be displayed in the left pane of the window. Right pane of 
the window displays the respective items of the folder selected from the left pane. Bottom pane displays 
the preview of the item selected from the right pane of the window. 

4. Click Export button to continue. 

Software asks for the Save Options whether to Save in PST or Save in Exchange Server. 

 

Figure 3.5: Save Options 

5. Select the appropriate radio button and click OK button. 
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3.1.1.1 Saving with PST 

To save the GroupWise mailbox items in PST: 

1. Select the "Save in PST" radio button and click OK. 

 

Figure 3.6: Saving with PST 

2. Define PST Folder Path and PST File Name and click OK. 

 

Figure 3.7: Window asking for PST File location 

Software starts saving selected folders at the selected location. 
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Figure 3.8: Saving Process 

Emails and other items of the user mailbox are saved in new PST file with original folder structure of the 
Novell GroupWise mailbox. 

3.1.1.2  Saving with Exchange Server 

To save the GroupWise mailbox items in Exchange Server: 

1. Select the "Save in Exchange server" radio button and click OK. 

2. Provide the details for Microsoft Exchange Server, User Name, Password, and Domain Name and 
then click OK. 
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Figure 3.9: Exchange Server Information 

Software starts saving the mailbox items in MS Exchange Server user profile. 
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Figure 3.10: Saving in progress 

Emails and other items of the user mailbox are now saved. 

3.1.2 Login Mode 

Login mode provides three sub modes: Online, Caching and Remote. 

Online Mode 

1. Select the Online radio button to access the GroupWise mailbox in online mode. 

2. Type the User Id and Password of the mailbox which you want to migrate from Novell GroupWise to 
Exchange. 

3. Type the IP address and Port number of the computer where Novell GroupWise Server is installed. 
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Figure 3.11: Using Online Mode 

4. Click Next button to proceed. 

Select any of the GroupWise mailbox items to view its contents. 

5. Click Export button to save the mails. 

Software asks for the Save Options whether to Save in PST or Save in Exchange Server. 

6. Select the appropriate radio button and click OK button. 

The saving process is same as described in Section 3.1.1.1 and 3.1.1.2. 

Caching Mode 

1. Select the Caching mailbox path radio button to access the GroupWise mailbox in cache mode. 

2. Type the User Id and Password of the mailbox which you want to migrate from Novell GroupWise to 
Exchange. Also define the caching mailbox path with the ... button. 
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Figure 3.12: Using Caching Mode 

3. Click Next button to proceed. 

4. Further steps are same as step 5 and 6 of above mentioned Online Mode. 

Remote Mode 

1. Select the "Remote mailbox path" radio button to access the GroupWise mailbox in remote mode. 

2. Type the password of the mailbox which you want to migrate and define the remote mailbox path 
through the ... button. 
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Figure 3.13: Using Remote Mode 

 Password is required for only those mailboxes which are password protected, 
otherwise there is no need to provide password for authentication. 

3. Rest steps are same as step 5 and 6 of above mentioned Online Mode. 

3.1.3 Command Line Mode 

Command Line mode helps you to access the GroupWise mailbox without opening or accessing the 
Novell GroupWise.exe and user mailbox account. If you know the path where GroupWise mailbox is 
saved, then type the path in Command Line mode and access that user mailbox for migration. 

1. Select Command Line (for advance migration) radio button to perform the migration with Command 
Line Mode. 

2. Type the User ID, Password and the User GroupWise Mailbox path. 
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Figure 3.14: Using Command Line Mode 

 Remote Novell GroupWise mailbox can be accessed with the switch and the 
complete path of the mailbox which is required to be migrated. 

3. Click Export button from the toolbar or simply click Next button to continue. 

4. Rest steps are same as steps 5 and 6 of above mentioned Online Mode. 

3.2 Multiple Mailbox Migration 

Multiple Mailbox Migration lets you migrate unlimited GroupWise files at once. Batch file is one medium 
with which you can easily list and convert unlimited GroupWise user mailboxes at once. Batch file stores 
records of unlimited GroupWise user mailbox accounts. Creation of batch file eases the task of defining 
saving location and saving mode for the converted mailboxes in PST or Exchange Server. 

3.2.1 Creating .NUCON Batch file 

1. Launch Kernel for Novell GroupWise to Exchange Migration File Creator software. 
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Figure 3.15: Main window of File Creator software 

2. Select „Add Record‟ option from the File menu or click the ‘Add Record‟ button from the tool bar. 

3. Provide the various related information, as in, user id, password, online, caching mailbox details, etc. 
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Figure 3.16: GroupWise Information 

 Select any of the modes (Online, Caching, Remote, and Command Line) to get 
access to the GroupWise user mailbox. 

4. After filling up all the relevant information, click Next button. 

As you click Next, Kernel for Novell GroupWise to Exchange Migration File Creator software provides 
saving options: Save in PST and Save in Exchange Server to choose from it. 
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Figure 3.17: Outlook/Exchange Information 

5. Select any of the saving option and provide the details accordingly. 
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Figure 3.18: Information for Exchange Server 

6. Click Finish button to continue. 

All the created records of the GroupWise User Mailboxes get listed in the software. 
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Figure 3.19: Created Records 

7. Click the Save button from the tool bar to save the batch file or click the Save As button to select and 
define saving location for the batch file on your computer system. 

 

Figure 3.20: Saving .NUCON file 

 Kernel for Novell GroupWise to Exchange Migration File Creator software by default 
creates *.NUCON file extension for the created batch file for multiple mailbox 
conversion. 
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3.2.2 Creating Excel Database 

Excel datasheet is another way of performing multiple mailbox migration. Information regarding various 
Novell GroupWise user mailboxes is easily saved to an excel worksheet according to the provided file 
format. Save details in .XLS file and export it to Kernel for Novell GroupWise to Exchange Migration File 
Creator software to get it saved to .NUCON batch file. 

Excel sheet (.XLS) to be imported should be in the following format. 

 

 

Figure 3.24: Excel sheet format 

1. Tab name of the sheet should be NucleusExcelSheet. 

2. Sheet should consist of 19 columns. 

Field 1 Mode 

Field 2 User ID 

Field 3 Password 

Field 4 Address 

Field 5 Port 

Field 6 Caching Mailbox Path 
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Field 7 Remote Mailbox Path 

Field 8 Command Line 

Field 9 User Name 

Field 10 User Password 

Field 11 Computer Name/IP 

Field 12 PST File Path 

Field 13 PST File Name 

Field 14 Exchange Server Name 

Field 15 Exchange Mailbox 

Field 16 Exchange Server Password 

Field 17 Domain 

Field 18 Save Archive 

Field 19 Archive Path 

3. Fill up the fields according to the login type selected amongst 

 Online 

Following are the mandatory fields to be filled in while using this mode: 

I. User ID: Type the user name of the mailbox.  

II. Password: Type the password of user mailbox.  

III. Address: Type the IP address of the Novell GroupWise Server  

IV. Port: Type the Port Number of the Novell GroupWise Server. 

V. Archive Details: Always type "NO" in this field if you want to migrate the mailbox items only.  

VI. Save in PST: There are two fields in this option:  

 PST File Path 

 PST File Name  
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If you want to save the migrated items in PST file then type the PST path location in both the fields, 
otherwise it will be an error.  

VII. Save in Exchange Server: There are four fields in this option:  

o Exchange Server Name 

o Exchange Mailbox 

o Password 

o Domain 

If you want to save the migrated items to the user mailbox on MS Exchange Server, then all the four 
fields are compulsory, otherwise it would be an error.  

 NOTE: Only one amongst “Save in PST” and “Save in Exchange Server” should be 

filled, otherwise software will display an error.  

 Caching Mailbox Path 

Following are the mandatory fields to be filled in while using this mode: 

I. User ID: Type the user name of the mailbox. 

II. Password: Type the password of user mailbox (if any). 

III. Caching Mailbox Path: Browse and list the path for Caching Mailbox of Novell GroupWise account 
to be migrated. 

IV. Archive Details: Always type "NO" in this field if you want to migrate the mailbox items only. 

V. Advance Options: Provide details to these fields if you are accessing the Caching mailbox from a 
network computer. This section will comprise of the login details of the computer in network. There 
are three fields in advanced options: 

VI. User Name of the network computer where mailbox is saved 

VII. Password of the network computer where mailbox is saved 

VIII. Computer Name/IP of the network computer where mailbox is saved 

IX. Advanced options fields are not compulsory, but recommended. If not filled, it will be shown as a 
warning.  

X. Save in PST: There are two fields in this option:  

 PST File Path  

 PST File Name  
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XI. If you want to save the migrated items in PST file then type the PST path location in both the fields, 
otherwise it will be an error.  

XII. Save in Exchange Server: There are four fields in this option:  

o Exchange Server Name 

o Exchange Mailbox 

o Password 

o Domain 

If you want to save the migrated items to the user mailbox on MS Exchange Server, then all the four fields 
are compulsory, otherwise it would be an error.  

 NOTE: Only one amongst “Save in PST” and “Save in Exchange Server” should be 

filled, otherwise it will be an error. 

 Remote Mailbox Path 

Following are the mandatory fields to be filled in while using this mode: 

I. Password: Type the password of user mailbox (if any). 

II. Remote Mailbox Path: Browse and list the path of remote mailbox path of Novell GroupWise 
account to be migrated. 

III. Archive Details: Always type "NO" in this field if you want to migrate the mailbox items only. 

IV. Advance Options: Provide details to these fields if you are accessing the Remote mailbox from a 
network computer. This section will comprise of the login details of the computer in network. There 
are three fields in advanced options: 

a. User Name of the network computer where mailbox is saved 

b. Password of the network computer where mailbox is saved 

c. Computer Name/IP of the network computer where mailbox is saved 

V. Save in PST: There are two fields in this option: 

a. PST File Path 

b. PST File Name 

VI. If you want to save the migrated items in PST file then type the PST path location in both the fields, 
otherwise it will be an error. 

VII. Save in Exchange Server: There are four fields in this option: 
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a. Exchange Server Name 

b. Exchange Mailbox 

c. Password 

d. Domain 

VIII. If you want to save the migrated items to the user mailbox on MS Exchange Server, then all the 
four fields are compulsory, otherwise it would be an error. 

 NOTE: Only one amongst “Save in PST” and “Save in Exchange Server” should be 

filled, otherwise it will be an error. 

 Command Line (for advanced migration) 

Following are the mandatory fields to be filled in while using this mode: 

I. User ID: Type the user name of the mailbox. 

II. Password: Type the password of user mailbox. 

III. Command Line: This field is compulsory. If this field is left blank, error will be shown. 

IV. Archive Details: Always type "NO" in this field if you want to migrate the mailbox items only. 

V. Save in PST: There are two fields in this option: 

 PST File Path 

 PST File Name 

VI. If you want to save the migrated items in PST file then type the PST path location in both the fields, 
otherwise it will be an error. 

VII. Save in Exchange Server: There are four fields in this option: 

 Exchange Server Name 

 Exchange Mailbox 

 Password 

 Domain 

VIII. If you want to save the migrated items to the user mailbox on MS Exchange Server, then all the 
four fields are compulsory, otherwise it would be an error. 

 NOTE: Only one amongst “Save in PST” and “Save in Exchange Server” should be 

filled, otherwise it will be an error.  
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3.2.3 Importing Excel Database 

Once done with the creation of Excel (.XLS) sheet, you are ready to import the same to Kernel for Novell 
GroupWise to Exchange Migration File Creator and save it as .NUCON file. Follow the given steps: 

1. Launch Kernel for Novell GroupWise to Exchange Migration File Creator software. 

 

Figure 3.25: File Creator software 

2. Click Import Excel button from the toolbar. Software displays the Open window to select the 
NucleusMigrationFile (.XLS) from the saved location. 
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Figure 3.26: Selecting .XLS file 

3. Browse and list the excel sheet. As you list the file in software, it displays a window with compilation 
output for the total records scanned from the excel sheet. 
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Figure 3.27: Compilation Output 

4. Modify the excel sheet as per the compilation output provided by the software. If there are no errors 
then click OK to proceed. 

Saved mailbox details get listed in the software. 

 

Figure 3.28: Listing of Mailboxes 

5. Click the Save As button from the toolbar to save the listed items as .NUCON batch file at appropriate 
location. 

6. Launch Kernel for Novell GroupWise to Exchange Migration software- main application and select the 
option to convert batch of GroupWise Mailboxes and list the .NUCON batch file for migration. 

3.2.4 Using .NUCON Batch file for Multiple Mailbox Migration 

Now that the .NUCON Batch file has been created, you can easily perform the multiple mailbox migration 
with the help of .NUCON file. Follow the simple steps given below: 

1. Launch Kernel for Novell GroupWise to Exchange software. The main window appears as 
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Figure 3.21: Main window 

2. Select the "Select this option to convert batch of GroupWise mailboxes" radio button and click 
Next button. 

The "Open" window gets displayed. 
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Figure 3.22: ‘Open’ window 

3. Select the batch file of .NUCON file extension and click the "Open" button. 

 

Figure 3.23: .NUCON file listed 
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4. Click the Export button to perform the migration of unlimited GroupWise mailboxes to PST or 
Exchange Server. 

After that the software starts the saving process and saves the converted items at the defined location. 

 The saving process is same as described above in Single Mailbox Migration section. 

3.2.5 Saving with Exchange Server (for multiple mailbox conversion option) 

Save in Exchange Server option for multiple mailbox conversion is pre-defined while creating the batch file 
of unlimited user mailboxes records in Kernel for Novell GroupWise to Exchange Migration File Creator 
software. Following is the process which gets followed while saving the files in MS Exchange Server user 
profiles: 

1. Click the radio button „Select this option to convert batch of GroupWise Mailboxes‟. 

 

Figure 3.29: Main Window 

2. Click „Next‟ to continue. 

3. List the .NUCON file (the created batch files) with Select File button. 
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Figure 3.30: Listing of .NUCON file 

4. Click the Export button. 

Software will start saving the files in the defined Exchange Server user profiles. 

After successful saving, Kernel for Novell GroupWise to Exchange Server will display the "Saving 
Complete" message which means that emails and other items of Novell GroupWise mailbox are saved 
successfully to the User mailbox on MS Exchange Server. 
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4. Advanced Options to make the Migration More 

Efficient 

Advanced options are provided in Kernel for Novell GroupWise to Exchange software for the user to ease 
the task of email migration from Novell GroupWise to Exchange mailboxes or PST files, as per the 
requirement. 

4.1 Migration of Archived Emails 

Kernel for Novell GroupWise to Exchange features migration of archived items of GroupWise user 
mailbox(s). Activate the Show Archive checkbox from the "Migrate Archive items" section. Following two 
options are provided for migration of archived items: 

 Use default Archive path: This option takes the default archive file location of the default user 
profile configured and opened in Novell GroupWise client. 

 Specify Archive path: This option takes the file path specified by you for archived file for user 
mailboxes other than the default one. 

 If you have selected Login Mode(s) or Command Line mode then you should always 
use Specify Archive path option to define archive file location of the user mailbox 
listed in Login or Command Line fields. If Use default Archive path option is 
selected, then the software will display the archived items of default user profile 
configured in GroupWise for migration. 

 

 When you opt for archive migration, software will list only the archived file items for 
preview and saving. Other mailbox items are not displayed when you select to 
migrate archived items. 
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Figure 4.1: Select Archive Option 

4.2 Migration of all Address Books 

Kernel for Novell GroupWise to Exchange enables migration of all the address books at a go. 

Once the .NUCON file is selected for export, software starts the process of saving. Before starting the 
process, software displays the message for address book migration. 

Do you want to export address book also? 

 

Figure 4.2: Message asking for exporting address book 

Click „Yes‟ if you want to export address book, otherwise „No‟ if you do not want to. 
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4.3 Folder Selection for Batch Migration of GroupWise Mailboxes 

Advanced options help you to select/deselect various options that filter your migration process. 

To view and implement advance options select Advance Options from Tool menu. 

 

Figure 4.3: Advance Options 

4.3.1 Export into existing folders in Exchange Mailbox 

Select this option, if you want to save the migrated items into existing folders of MS Exchange Server user 
mailbox. 

 In case of migrating items from orphan GroupWise folders: for any folder which 
exists in GroupWise mailbox but does not exist in the Exchange server mailbox, 
software will create a new folder of its original name in Exchange mailbox and export 
items to that folder. 
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4.3.2 Prompt for folder selection for each mailbox, while using batch file mode 

Software enables you to select desired folders for saving during batch file migration process. You can 
select appropriate folders for saving while performing migration with Kernel batch file of multiple mailboxes 
at once. 

 

Figure 4.4: ‘Folder Selection’ window 

The Folder Selection window appears during the batch migration process, when Prompt for folder 
selection for each mailbox, while using batch file mode checkbox is selected. From this window, you 
can select the folders to save. If you do not want this dialog box to appear again and again, select the 
Never show this dialog again and save all folders or deselect the "Prompt for folder selection for each 
mailbox, while using batch file mode checkbox” from Advance Options. By this all the folders which exist in 
the mailbox will get saved automatically and software will not prompt you to select or deselect the folders. 

4.3.3 Show all Address Books 

Select this checkbox to view all the address books of GroupWise mailbox during mailbox preview before 
saving the items. 

4.3.4 Advance Settings for Sent Items 

Select this checkbox to activate advance settings for Sent Items conversion. If in case, the Sent Items 
folder emails are listed and converted slowly, then select this option to make it fast. Kernel for Novell 
GroupWise to Exchange software speeds-up the migration process with this option. 
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4.3.5 Do not save Calendar items in Calendar view 

Select this checkbox to save the migrated calendar items in list view in MS Outlook instead of the default 
calendar view. 

4.4 Modifying GroupWise Folder Names as per Outlook/Exchange 

You can change the folder names of GroupWise mailbox while migrating to MS Outlook or MS Exchange 
Server. 

 

Figure 4.5: Modifying GroupWise Folder Names 

Select the checkbox “Change name of GroupWise folders while migrating to Outlook or Exchange” 
to activate the section where Default GroupWise Folders name, GroupWise folders and Outlook/Exchange 
Folders are listed. From here you can easily modify the folder names of GroupWise mailbox and MS 
Outlook/MS Exchange Server mailboxes for migration. After that click Apply button and then OK button. 

This option is supportive to Unicode language folder migration.
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5. Difference between Evaluation and Full Version 

The free to download Evaluation version of Kernel for Novell GroupWise to Exchange is fully functional in 
its conversion capabilities. 

It converts your Novell GroupWise mailboxes and saves them in PST file or in MS Exchange Server 
mailbox. The demo version shows complete preview of the converted emails with data but will save only 
first 10 emails per folder existing in the User Mailbox to PST or MS Exchange Server. 

Purchasing the Full version delimits the saving restrictions and saves as many user mailboxes as required 
by the user. 
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6. Purchase and Support 

6.1 Purchase Kernel for Novell GroupWise to Exchange 

You must purchase Kernel for Novell GroupWise to Exchange software in order to save entire converted 
email messages of Novell GroupWise mailboxes. The free evaluation version of Kernel for Novell 
GroupWise to Exchange software lets you save 10 emails per folder of the converted GroupWise mailbox. 

You can purchase the Kernel software through Nucleus Data Recovery website: 

http://www.nucleustechnologies.com/buy-groupwise-to-exchange.php (encrypted and secure site) 

Payment and Delivery 

Purchase the Kernel software with our authorized resellers which provide number of payment options for 
your ease - Paypal, FAX, Credit Card, E-cheque, Pay Order etc. For other methods, please email us to 
sales@nucleustechnologies.com 

After making the purchase transaction with our resellers, we send you an email which consists of 
activation details and download link of the full version comprising of activation code. This email is sent to 
the mail address which you have used while processing the purchase transaction with our resellers. 

 Important: It is advised to avoid using false email address while making the 

purchase transaction. 

6.2 Support Options for Kernel for Novell GroupWise to Exchange 

Web Support 

Online Help: 

If you have queries relating to the use of Kernel for Novell GroupWise to Exchange software, you can visit 
our online help to have some more clarification to the usage of the software. 

Online Help: http://www.nucleustechnologies.com/Online-Helps.html 

Knowledgebase: 

There is extensive knowledgebase which deals with common queries relating to the software: 

Visit knowledgebase: http://www.nucleustechnologies.com/supportdesk/ 

Chat Support: 

You can also get the help of our experts online by visiting our chat support section. You can communicate 
directly to our experts online. 

Chat Support: http://www.nucleustechnologies.com/Support.html 

http://www.nucleustechnologies.com/buy-groupwise-to-exchange.php
http://www.nucleustechnologies.com/Online-Helps.html
http://www.nucleustechnologies.com/supportdesk/
http://www.nucleustechnologies.com/Support.html


© N u c l e u s  D a t a  R e c o v e r y . C o m  P r i v a t e  L i m i t e d   

Telephone Support 

Helpline:  
 
+91-9818725861 

1-866-348-7872 (Toll Free USA/CANADA) 

Email Support 

For Sales: sales@nucleustechnologies.com 

For Support: support@nucleustechnologies.com 

For General Queries: contact@nucleustechnologies.com 

mailto:sales@nucleustechnologies.com
mailto:support@nucleustechnologies.com
mailto:contact@nucleustechnologies.com
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7. Legal Notices 

This section comprises the legal specification about Kernel for Novell GroupWise to Exchange and the 
company NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED 

7.1 Copyright 

NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED, Nucleus Kernel accompanied user manual and 
documentation are copyright of NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED, with all rights 
reserved. Under the copyright laws, this user manual cannot be reproduced in any form without the prior 
written permission of NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED. No Patent Liability is 
assumed, however, with respect to the use of the information contained herein. 

© NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED. All rights reserved. 

7.2 Trademark 

Nucleus Kernel ® is a copyright work of NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED 

Windows 95®, Windows 98®, Windows ME®, Windows NT®, Windows 2000 Server®, Windows 2000 
Advanced Server®, Windows 2003 Server®, Windows XP®, MS Outlook, MS-DOS, MS Office, MS 
Exchange Server and Novell GroupWise Client and Novell GroupWise Server are registered trademarks 
of Microsoft Corporation and Novell Inc. 

All other brand and product names are trademarks or registered trademarks of their respective 
companies. 

7.3 Disclaimer 

The Information contained in this manual, including but not limited to any product specifications, is subject 
to change without notice. NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED provides no warranty 
with regard to this manual or any other information contained herein and here by expressly disclaims any 
implied warranties of merchantability or fitness for any particular purpose with regard to any of the 
foregoing NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED assumes no liability for any damages 
incurred directly or indirectly from any technical or typographical errors or omissions contained herein or 
for discrepancies between the product and the manual. In no event shall NUCLEUS DATA 
RECOVERY.COM PRIVATE LIMITED, be liable for any incidental, consequential special, or exemplary 
damages, whether based on tort, contract or otherwise, arising out of or in connection with this manual or 
any other information contained herein or the use there of. 

7.4 License Agreement 

Kernel for Novell GroupWise to Exchange software is Copyright work of NUCLEUS DATA 
RECOVERY.COM PRIVATE LIMITED 

Your Agreement to this License 
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You should carefully read the following terms and conditions before using, installing or distributing this 
software, unless you have a different license agreement signed by NUCLEUS DATA RECOVERY.COM 
PRIVATE LIMITED. The terms and conditions of this License describe the permitted use and users of 
each Licensed Copy of Kernel for Novell GroupWise to Exchange software. For purposes of this License, 
if you have a valid license, you have the right to use a single Licensed Copy of Nucleus Kernel. 

Scope of License 

Each Licensed Copy of Kernel for Novell GroupWise to Exchange software may either be used by a single 
person or used non-simultaneously by multiple people who use the software personally installed on a 
single workstation. All rights of any kind in Nucleus Kernel, which are not expressly granted in this 
License, are entirely and exclusively reserved to and by NUCLEUS DATA RECOVERY.COM PRIVATE 
LIMITED. You may not rent, lease, modify, translate, reverse engineer, decompile, disassemble, or create 
derivative works based on, Nucleus Kernel, nor permit anyone else to do so. You may not make access to 
Nucleus Kernel available to others in connection with a service bureau, application service provider, or 
similar business, nor permit anyone else to do so. 

Warranty Disclaimers and Liability Limitations 

Kernel for Novell GroupWise to Exchange software, and any and all accompanying software, files, data 
and materials, are distributed and provided as is and with no warranties of any kind, whether expressed or 
implied. In particular, there is no warranty for the quality of data recovered. You acknowledge that good 
data processing procedure dictates that any program, including Nucleus Kernel, must be thoroughly tested 
with non-critical data before there is any reliance on it, and you hereby assume the entire risk of all use of 
the copies of Nucleus Kernel covered by this License. This disclaimer of warranty constitutes an essential 
part of this License. In addition, in no event does NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED 
authorize you or anyone else to use Kernel for Novell GroupWise to Exchange software in applications or 
systems where Kernel for Novell GroupWise to Exchange software failure to perform can reasonably be 
expected to result in a significant physical injury, or in loss of life. Any such use is entirely at your own risk, 
and you agree to hold NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED harmless from any and all 
claims or losses relating to such unauthorized use. 

General 

This License is the complete statement of the agreement between the parties on the subject matter, and 
merges and supersedes all other or prior understandings, purchase orders, agreements and 
arrangements. This License shall be governed by the laws of the State of Delhi. Exclusive jurisdiction and 
venue for all matters relating to this License shall be in courts and for a located in the State of Delhi, and 
you consent to such jurisdiction and venue. There are no third party beneficiaries of any promises, 
obligations or representations made by NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED herein. 
Any waiver by NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED of any violation of this License by 
you shall not constitute, nor contribute to, a waiver by Nucleus Data Recovery of any other or future 
violation of the same provision, or any other provision, of this License. 


